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Chapter 4.  Installing and configuring a Domino cluster

This chapter will cover the installation and configuration steps for clusters 
using Domino Enterprise Server Release 5.0.4a. Initially, we discuss 
installing Domino servers running on Windows 2000. Then, in 4.4, “Installing 
Domino R5 for Linux on IBM Netfinity servers” on page 106, we cover the 
areas that are significantly different when your servers are running Linux as 
their base operating system.

We will focus on the following topics:

  • Installing a new cluster

  • Modifying the cluster configuration (by adding, moving, or deleting a 
server)

  • Upgrading a standard server to a clustered server

  • Configuring calendaring and scheduling in a cluster

  • Configuring Internet Cluster Manager (ICM)

  • Hints and tips for installation problems

We will also discuss specifics of the installation and configuration steps for 
the Domino Enterprise Server Release 5.0.4a on Linux.

4.1  Prerequisites

In order to install Domino Cluster features, you must have installed and 
configured a working Windows 2000 server environment. You must also have 
configured the network protocols that will be used in your Domino 
environment.

Lotus Domino Enterprise Server requires the TCP/IP protocol for 
communication between cluster members. You can install and configure other 
protocols to be used in the Domino environment and the clients can access 
the databases using those protocols. It is necessary for all servers in a cluster 
to be configured with a consistent set of network protocols.
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The minimum system requirements for Domino clustering are listed in the 
following table. 

Table 5.  Minimum system requirements for Domino clustering

System requirements may vary greatly depending on the number of 
concurrent clients accessing the server, the database sizes, the transaction 
rate per second, and the number of replicated databases in the cluster.

In general, Domino clustering will require more resources than a standard 
Domino server. The following list indicates the major factors that influence 
resource requirements.

Feature Windows 2000 Linux

Operating system Windows 2000 Red Hat 6.0 (and later)
Caldera 2.2 (and later)
SuSE 6.3 (and later)
TurboLinux 6.0 (and later)

Processor types 133 MHz or higher 
Pentium-compatible

Intel x86

SMP Support Yes Yes

RAM 128 MB or more minimum
(256 MB recommended)

64 MB minimum

Disk space 2 GB (with a minimum of 1 GB 
free space)

750 MB minimum (1 GB or 
more recommended)

Protocols TCP/IP
SPX
SPX II
NetBIOS, NetBEUI
AppleTalk
VINES
X.PC

TCP/IP
X.PC

Although other protocols may be used in addition to TCP/IP, we 
recommend that you use TCP/IP for both client to server and inter-server 
cluster communications if possible. The Domino cluster solution is 
optimized for TCP/IP, and provides faster failover times for clients using it 
than with other protocols.

Protocols
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  • The more replicas you create, the more disk space you need and the more 
processing power you need for cluster replication.

  • The more servers in the cluster, the more processing power each server 
uses to communicate with the other cluster servers.

  • The more server tasks and CPU-intensive applications you run on a 
server, the more processing power you need.

  • The more users a server has to handle concurrently, the more memory the 
server needs to keep performance acceptable.

All servers in a cluster must run the Domino Release 5 or Release 4.62 
Enterprise server license, or the Domino Release 4.5 or Release 4.6 
Advanced Services license. All necessary software is included on the Lotus 
Domino CD-ROM.

To install a Domino cluster, the following conditions must be met:

  • All servers in a cluster must be connected using a high-speed local area 
network (LAN). You can also set up a private LAN to separate cluster 
traffic from client traffic.

  • All servers in a cluster must use TCP/IP and be on the same Notes named 
network.

  • All servers in a cluster must be in the same Domino domain and share a 
common Domino directory.

  • You must specify an administration server for the Domino Directory in the 
domain that contains the cluster. If you do not specify an administration 
server, the Administration Process cannot change cluster membership. 
The administration server does not have to be a member of a cluster or be 
running the Enterprise Server license.

  • Each server in a cluster must have a hierarchical server ID. If any servers 
have flat IDs, you must convert them to hierarchical IDs to use them in a 
cluster.

  • A server can be a member of only one cluster at a time.

  • Each server must have adequate disk space to function as a cluster 
member.

  • Each server must have adequate processing power and memory capacity.

With these prerequisites in place, you can now install Domino.
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4.2  Hardware setup

All of the examples discussed in this chapter use the same hardware. The 
configurations we discuss are genuine ones that we constructed in our server 
lab. We chose to run Domino on four IBM Netfinity servers: two IBM Netfinity 
7000 M10 4-way servers and two IBM Netfinity 5500 servers. The IBM 
Netfinity 7000 servers were equipped with 2 GB memory, 18 GB disk space 
on ServeRAID-attached disks, and IBM Token-Ring and IBM Ethernet 
adapters for network connectivity. All of the hard disks on a particular server 
were configured as a RAID-5 array, then as a single logical drive within the 
array. This logical drive then appears to the operating system as a single 
physical drive. We installed Windows 2000 on the two IBM Netfinity 7000 M10 
servers and partitioned the logical drive as shown in the following table:

Table 6.  Disk configuration on Windows 2000 server

The two IBM Netfinity 5500 servers were equipped with 256 MB memory, 18 
GB disk space on ServeRAID-attached disks, and IBM Token-Ring and IBM 
Ethernet adapters for network connectivity. All of the hard disks on a 
particular system were grouped into a RAID-1 array and defined as one 
logical drive. This logical drive then appears to the operating system as a 
single physical drive. On these IBM Netfinity 5500 servers we installed two 
different distributions of Linux. For one server we used Red Hat 6.2, and, for 
the other, SuSE 6.4. 

Drive letter Space Component

C: 2 GB Operating system

D: 4 GB Paging file

Domino program files

E: 8 GB Domino databases

F: 4 GB Domino transaction log
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We partitioned the logical drive as shown in the following table:

Table 7.  Disk configuration on Linux server

If your server has less than 512 MB of memory, the swap partition should be 
three to four times the size of your physical RAM. If your RAM size is 512 MB 
or more, then set the swap partition size equal to the amount of RAM you 
have in your system. For our configurations, we allocated 1 GB to the Linux 
swap partition. 

The hardware setup used here is not intended as a recommendation. The 
actual hardware required to provide Notes or Web clients with acceptable 
response times varies greatly from one installation to another, depending 
upon many factors including network infrastructure, number of users, and the 
types of applications and services provided. 

Mount point Partition size

/ 256 MB

<swap> See accompanying text

/boot 50 MB

/home 512 MB

/data 4096 MB

/data/log 1024 MB

/opt 1024 MB

/tmp 512 MB

/usr 2048 MB

/var 512 MB

Note that the maximum supported swap partition size for the latest kernel 
2.2-based Linux distributions is approximately 2 GB. Kernels prior to 2.2 
limit swap partitions to 128 MB. For these earlier kernels, larger partitions 
can be allocated, but waste space, since only the first 128 MB are actually 
used. To provide more than 128 MB of swap space requires that you 
configure multiple swap partitions. These can be located inside a disk’s 
extended partition.

Swap partition size limit



82 Lotus Domino R5 Clustering

To keep our lab systems relatively simple, we used a single array/logical drive 
configuration as already discussed. You will want to pay more attention to 
organizing your disk subsystem to optimize performance. Deciding exactly 
where the various files used by Domino should be located is quite crucial for 
performance. See 2.3, “Planning cluster hardware” on page 21 to read more 
about hardware components considerations for your cluster, including a 
discussion about the disk subsystem.

Figure 15 illustrates the network and the Domino servers we installed in our 
lab environment:

This scope of this book prevents a detailed discussion of disk organization 
and the potential impact it can have on server performance. It is, however, 
worth mentioning one or two items of particular relevance: 

  • Placing the swap partition on a dedicated drive or on its own RAID array 
can give performance advantages. Using an array gives the added 
advantage that multiple disk spindles are active simultaneously, 
providing greater throughput than for a single disk. 

  • A similar argument applies for Domino R5’s transaction logs. Whenever 
possible, a separate dedicated disk drive or array should be used for 
these logs.

For more information about Domino performance, see the IBM Redbook 
Netfinity and Domino R5.0 Integration Guide, SG24-5313. A useful guide to 
improving server performance in general is another Redbook, Tuning 
Netfinity Servers for Performance, ISBN 0-13-040612-0.

Disk organization and performance
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Figure 15.  A four-node Domino cluster

All servers were connected using a dedicated Ethernet LAN connection.

We installed a 10/100 Mbps Ethernet adapter in each server, each connected 
to an Ethernet hub, to create a private network for the cluster traffic. Although 
this setup requires more hardware than would be necessary if the client 
network were used for cluster traffic, the resulting solution reduces traffic on 
the client network, and the additional cost is relatively small. 

The network load that the cluster traffic will generate depends on the number 
of clustered nodes and number of update transactions between nodes. We 
therefore particularly recommend this approach for Domino clusters that 
provide service to large numbers of users or that will generate significant 
cluster traffic. 

Lotus Domino Server can use any network topology supported by the 
underlying operating system.

TCP/IP Network
for Client Traffic

Dedicated LAN Connection for Cluster Communication

saturn.itso.ral.ibm.com

sun.itso.ral.ibm.com

192.168.148.104

192.168.148.101
192.168.148.101 192.168.148.101
mars.itso.ral.ibm.com venus.itso.ral.ibm.com
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4.3  Installing a new Domino cluster

In this section we will describe how to install Lotus Domino Enterprise Server 
and how to configure a cluster.

The installation steps can be summarized as follows:

1. Install the first Domino server.

2. Configure the first Domino server:

a. Configure the server name, organization and domain.
b. Configure the ports, protocols and named network.
c. Start the server.

3. Prepare to install the remaining cluster servers:

a. Create the certification log.
b. Register additional servers.

4. Install and configure the remaining cluster servers. For each of them:

a. Install the program files.
b. Configure the server name, organization and domain.
c. Configure the ports and protocols and named network setup.
d. Start the server.

5. Create the cluster:

a. Create the cluster using the Domino Directory.
b. Verify that the cluster database directory file is replicated or replicate 

the file manually to all the servers in the cluster.
c. Configure the communication port for the backbone communication 

between the servers participating in the cluster.

6. Test the cluster.

We now take you through each of these steps in turn.

4.3.1  Installing the first Domino server 
Installing the first Domino server consists of the following simple steps. Note 
that TCP/IP is the only protocol stack used at this point of the cluster 
installation.

1. Insert the Lotus Domino CD-ROM and start the server installation program 
from an appropriate directory.

2. Read and accept the license terms.

3. Enter the user registration information.
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4. In the Lotus Domino Installation window, select the program and data 
directories to be used for the Domino server. 

It is a recommended practice to install the Domino data directory on a 
dedicated partition. In our case we used the drives as defined in Table 6 
on page 80.

5. Select the Domino Enterprise Server radio button to install a Domino 
server that includes Domino clustering as shown in Figure 16:

Figure 16.  Domino Enterprise Server installation

6. Click Customize and select the components you want to install; Domino 
as an NT service, for example.

7. Installation will add program icons to the Lotus Applications folder. You 
may type a new folder name.

8. Click Next and the installation process will proceed to completion.
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4.3.2  Configuring the first Domino server 
This section, describing the configuration of the first server, is divided into two 
parts: the general configuration and the port and named network 
configuration.

4.3.2.1  General configuration
After the code installation phase has completed, the server must be 
configured in the same way as a standard Domino server. To configure the 
first server follow the steps below:

1. Select Start -> Programs -> Lotus Applications -> Domino Server. 
When you start the server for the first time after installation, the Domino 
setup client will run automatically.

2. Select the First Domino Server radio button in the first setup window.

3. Select Advanced setup in the second setup window.

4. Select the additional services that you want to run in the New Domino 
Server third setup window. 

5. Enter the required information for the Domino server in the last setup 
window. Figure 17 shows the setup and naming conventions for our lab 
setup.

If you plan to provide failover benefits to Web clients, you will need to 
select Domino’s HTTP service for installation. Remember to disable the 
Windows 2000 World Wide Web Publishing service provided by 
Microsoft’s Internet Information Server (IIS) if this is installed.

Web clusters
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Figure 17.  The first Domino server configuration

Note that we have opted to configure the ports manually. This is done so 
that all the unwanted protocols will be disabled.

6. To configure the ports during the initial configuration, select Customize... 
in the Network Options section and click Edit Ports. The Port Setup 
window is displayed.

7. Disable all but TCP/IP and verify that the settings for the port are correct, 
then click OK. The Port Setup window for the example setup configuration 
is shown in Figure 18:
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Figure 18.  Modifying the port settings

8. After filling in the required configuration information, complete the setup 
process by clicking Finish (Figure 17).

9. After completing the Notes configuration, it is recommended that two 
settings are changed to optimize the Windows 2000 environment for the 
Domino server:

  - Select Start -> Settings -> Control Panel -> System Properties -> 
Advanced tab. Click Performance Options and select Background 
services as shown in Figure 19:

Figure 19.  Changing Windows 2000 performance options
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Click OK to close the dialog box.

  - Select Start -> Settings -> Network and Dial-up Connections. 

  - Double-click the icon for the network adapter being used by the Domino 
server, and click Properties in the Status window that appears.

  - Select File and Printer Sharing for Microsoft Networks. Click 
Properties and select Maximize data throughput for network 
applications as shown below:

Using Windows NT 4.0, this setting eliminates the following 
message, displayed in the Domino console during startup:

Informational: The registry value 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\PriorityControl\
Win32PrioritySeparation is currently set to 2. For better server 
performance, change the setting to 0

Using Windows 2000, the setting changes the value from 38 to 24 
and the message is still displayed. It can safely be ignored.

Informational message
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Figure 20.  Maximizing server throughput

4.3.2.2  Port and named network configuration on the first server
We have emphasized the benefits of using a private network for cluster traffic 
several times. In our lab environment we used a token-ring network for client 
traffic and Ethernet for the private cluster network.

In the initial Domino server configuration we enabled the TCPIP port for client 
traffic. Now we have to set up another port to handle the cluster traffic. These 
are the steps we used:

1. From the Domino Administrator, select the Server tab.

2. Choose the server from the Servers pane.

3. From the Tools pane, choose Server -> Setup Port.

4. In the Communications Ports box, click New to create a new port name. 
We chose TCPCLUST. Do not use spaces in the name. 

5. Select the TCP driver.

6. Select the Port Enabled check box. You should now have the following 
information displayed in the Port Setup dialog box:
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Figure 21.  Creating a new port for cluster replication

Click OK to confirm your choices and close the dialog box.

7. From the Configuration tab, open the appropriate Server document in 
edit mode.

Select the Ports -> Notes Network Ports tab, and enter values for the new 
port as shown below:
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.

Figure 22.  Defining a port for cluster traffic

8. Save and close.

9. Finally, you should modify the NOTES.INI file to assign IP addresses to 
these ports. You will add TCP/IP address parameters for each port:

<TCPIP PortName>_TCPIPAddress=0,IP,port

If you are using host names instead of static IP addresses, make sure 
that the IP address can be resolved using DNS. If you are in any doubt 
about the reliability of DNS, use either static addresses or resolve the 
name in the server’s hosts file. The hosts file is located in the 
\WINNT\system32\drivers\etc directory on Windows 2000 server and in 
the \etc directory on the Linux server.

Host name or static IP address?
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Parameters are described in the following table:

Table 8.  Setting TCP/IP port parameters

Here is example of settings that we added to NOTES.INI file on one of our 
Domino servers in the cluster:

TCPIP_TCPIPAddress=0,9.24.104.198,0
TCPCLUST_TCPIPAddress=0,192.168.148.101,0

In our lab cluster, the TCPIP port was used for client connections and it used a 
real, registered TCP/IP address. TCPCLUST was the port we defined to provide a 
dedicated connection between servers in the cluster, our private LAN. We 
recommend that you use addresses from the TCP/IP address space reserved 
for private networks. According to the TCP/IP standard (RFC 1597), there are 
three private network address ranges, one for each address class:

  • 10.0.0.0 to 10.255.255.255 (class A)

  • 172.16.0.0 to 172.31.255.255 (class B)

  • 192.168.0.0 to 192.168.255.255 (class C)

4.3.3  Preparing additional cluster servers
The next step is to create server IDs for the remaining servers to be added to 
the cluster.

4.3.3.1  Creating the Certification Log
Before creating IDs for additional servers or users, you need to create a 
Certification Log for your Domino domain. Select File -> Database -> New... 
to invoke the New Database dialog box as shown in Figure 23:

Parameter Description

PortName Port name as defined on the Ports tab in Figure 22.

IP TCP/IP address for that port. Verify that it is the same 
address as defined in the Windows 2000 network 
configuration.

port TCP/IP port number on which the Domino server listens. 
This value should be set to zero or to the default Domino 
TCP/IP port 1352.
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Figure 23.  Creating the Certification Log database

The database name has to be CERTLOG.NSF. Also, remember that you need 
to select the administration server from the server list rather than the local 
server. Click OK to create the database.

4.3.3.2  Registering additional servers
Before you install additional servers, you must register them. In effect, 
registering a server adds the server to the domain. The server registration 
process creates both a Server document for the server in the Domino 
Directory and a server ID.

To complete this process, the following prerequisites must be in place:

  • The registration server, that is the one from which you register other 
servers, must be up and running.

  • You must have access to the registration server and have at least Author 
access with the ServerCreator role in the Domino Directory’s ACL.

  • You must have access to the certifier ID and its password.

To register each additional Domino server, follow the steps below:

1. From the Domino Administrator, click the Configuration tab.

2. From the Tools pane, click Registration -> Server.

3. Enter the certifier ID password and click OK.
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Domino uses either the certifier ID specified in Administration Preferences or 
the ID specified in the CertifierIDFile setting of NOTES.INI. If you want to 
switch from one to the other, click Certifier ID and make your selection.

4. Choose the Administration server as your registration server by using the 
Registration Server... button.

5. Select the security type and enter the expiration date of the server 
certificate.

6. Click Continue.

Figure 24.  Registering an additional Domino server

7. In the Basics window, enter values for the Domino server name, 
Password, Domino domain and Administrator.

Figure 25.  Setting the server’s name
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8. Select the Other icon and enter values for Server title, Network, and Local 
administrator.

9. By default Domino stores the server ID file in the Server document of the 
Domino Directory. Instead of storing it in the Server document, you can 
store the ID in another location. To select another location, click Set ID file 
and select the name and path for the file. Click Save.

10.Finish the server registration by clicking the Register button.

Repeat the above steps for each server that you intend to add to the cluster. 
At the end of this step, all members of the cluster will be registered.

4.3.4  Installing and configuring additional cluster servers
This step includes information on how to install and configure the remaining 
Domino servers. Repeat the following process for each additional server.

4.3.4.1  Installation
Install the Domino server software in the same way as you did when installing 
the first Domino server. You must install Domino Enterprise Server on each 
server that will be added to the cluster.

4.3.4.2  Server configuration
After the Domino code installation phase is complete, the server must be 
configured. To configure the server follow the steps below:

1. Select Start -> Programs -> Lotus Applications -> Domino Server. The 
Domino setup client will be launched.

2. Select the Additional Domino Server radio button in setup window 1.

3. Select Advanced setup in setup window 2.

4. Select the additional services that you want to run on the New Domino 
Server in setup window 3. 

5. The New Domino Server setup window 4 is shown in Figure 26:
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Figure 26.  Using the ID file created earlier for the new server identity

6. In the New Server Identity section, select Server ID supplied in a file.

7. As with the first server, disable all ports except for TCP/IP.

8. Finish the configuration by clicking Finish. Accept the offer to copy the 
server ID file to the Domino data directory when prompted.

4.3.4.3  Port and named network configuration
After configuring the server, you need to set up an additional port for cluster 
communication if you decided to use a dedicated port for cluster traffic.

The second port is set up in exactly the same way as we did for the first 
Domino server (see 4.3.2.2, “Port and named network configuration on the 
first server” on page 90).

The above installation and configuration has to be completed for each server 
that is going to join the cluster.
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4.3.5  Creating a cluster
Now that all of the servers that you have planned to be members of the 
cluster have been installed and configured, it is time to add them to the 
cluster.

4.3.5.1  Adding servers to a cluster
When you add Domino servers to a cluster, use the administration server. 
The administration server does not have to be part of the cluster.

You must have at least Author access with Delete document rights and the 
ServerModifier and ServerCreator roles in the Domino Directory, and Author 
access in the Administration Requests database.

1. Using the Domino Administrator, make sure the administration server is 
current.

2. Select the Configuration tab.

3. Expand Server and click All Server Documents.

4. In the Results pane, select the servers you want to add to the cluster and 
click Add to Cluster. Figure 27 shows the resulting dialog box:

Figure 27.  Adding servers to a cluster

5. You are prompted to confirm the addition of selected servers to the cluster. 
Click Yes.
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6. The Cluster Name window is displayed. You can select either an existing 
cluster or, as in this case, select *Create New Cluster and click OK. You 
will be prompted to enter the name of the new cluster.

Figure 28.  Entering name of the new cluster

7. Enter a name of your choosing and click OK.

8. In the next dialog box, you can click Yes to add your servers to the cluster 
immediately or No to submit a request to the Administration Process to 
add the server to the cluster.

We recommend that you select Yes to add your servers to the cluster 
immediately. Their Server documents will be modified and, as soon as 
these changes in the Domino Directory are replicated to your new 
clustered servers, Domino clustering tasks will be initiated. The clustering 
tasks are Cluster Manager, Cluster Administrator, Cluster Database 
Directory Manager (CLDBDIR) and Cluster Replicator (CLREPL). Cluster 
Administrator adds task names CLDBDIR and CLREPL to the ServerTasks 
setting in NOTES.INI for each server so that these tasks start each time 
you start the server.

When you add servers to a cluster, there can be an initial performance impact 
due to the amount of replication that must take place to create the cluster 
replicas. Depending on the types of databases on the server and the number 
of replicas you create, adding a server can affect CPU performance, 
input/output and network traffic. Therefore, it may be a good idea to add only 
one or two servers at a time to a cluster, depending on the spare capacity of 
the systems in the cluster. If you set up a private LAN for cluster traffic, 
adding multiple servers at the same time will not be such a concern because 
it will not affect your primary network.

4.3.5.2  Dedicating the private port to cluster traffic
You should configure the TCP/IP port on the private LAN to be dedicated for 
the backbone communication between servers participating in the cluster. 
You can set it up either by editing NOTES.INI manually or by using a Server 
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Configuration document to update the NOTES.INI file on all servers in the 
cluster.

The following NOTES.INI entry controls the cluster traffic destination port:

Server_Cluster_Default_Port=PortName

where PortName is the port name defined in the Domino Directory. In our setup 
we added the line as shown:

Server_Cluster_Default_Port=TCPCLUST

You should also set the default port for cluster server probing. This port is 
used between the servers in the cluster to exchange information about cluster 
server status. The following NOTES.INI entry sets the probing port and 
should be added for all cluster members:

Server_Cluster_Probe_Port=PortName

where PortName is the name of the port to be used for server probing. Only a 
TCP/IP port should be used for server probing. This parameter is especially 
useful if the servers in the cluster are configured to run protocols other than 
TCP/IP. Using this parameter you can be sure that probing occurs on the 
TCP/IP port only.

To set the port for probing, we added the following setting on each Domino 
server in our cluster:

Server_Cluster_Probe_Port=TCPCLUST

After saving the changes to NOTES.INI, you should restart each Domino 
server.

4.3.5.3  Cluster Database Directory
The Cluster Database Directory (CLDBDIR.NSF) resides on every server in a 
cluster. The Cluster Database Directory contains a document about each 
database and replica in the cluster. This document contains such information 
as the database name, server, path, replica ID and database status.

The Cluster Database Directory and its replicas are kept up to date 
automatically by cluster replication. The quickest way to get an overall view of 
which databases are clustered and which servers are carrying replicas is to 
open the Cluster Database Directory and use the Databases by replica ID 
view as shown in Figure 29:
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Figure 29.  Cluster Database Directory

Because the Cluster Database Directory is so essential for the cluster’s 
operation, make sure that database replication was successful by comparing 
the replica IDs on all the servers in the cluster. The replica IDs should be the 
same.

4.3.5.4  Configuring replication in a cluster
Both scheduled and cluster replication are necessary within a cluster. Cluster 
replication is used as the primary means of keeping database replicas up to 
date in a cluster and scheduled replication is used as a backup to cluster 
replication within a cluster, as well as to synchronize database replicas 
outside the cluster.

Because of the dynamic nature of cluster replication, and the fact that 
database updates are stored in memory, there is a possibility that database 
updates may be missing in the event of hardware or network failure. For this 
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reason, it is recommended that scheduled replication is configured across the 
servers in a cluster. A suitable scheduled replication repeat interval will 
depend on both the number and the sizes of the databases on your servers.

Traditional scheduled replication relies on administrator-defined Connection 
documents in the Domino Directory. An example of how to configure a 
Connection document between clustered Domino servers is shown in Figure 
30:

Figure 30.  Connection document for scheduled replication

Remember that for each clustered server you must create a Connection 
document.

To ensure that all the replicated databases are up to date when the server 
starts, you can define replication to take place at startup by defining a new 
Program document in the Domino Directory. Refer to 5.6.4, “Setting up 
scheduled replication at server startup” on page 154 for more details.

In contrast to the predictable nature of scheduled replication, cluster 
replication is event driven. Whenever a change occurs to a database in the 
cluster, the Cluster Replicator immediately pushes the change to the other 
replicas in the cluster. This ensures that each time users access a database, 
they see the most up-to-date version. The Cluster Replicator also replicates 
changes to private folders that are stored in a database.
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Each server in a cluster runs one Cluster Replicator by default. This 
configuration is adequate if only a few moderately sized databases exist in a 
cluster consisting of two or three Domino servers. In typical high-volume 
clustered environments, we recommend that you should configure as many 
Cluster Replicator tasks on each server as there are total number of servers 
defined in the cluster, less one. This guideline suggests, for example, five 
Cluster Replicator tasks for a cluster composed of six servers. In this way, 
there will always be at least one CLREPL task available to handle replication 
requests to another server in the cluster.

To configure multiple Cluster Replicator tasks, append additional CLREPL 
instances to the ServerTasks parameter in NOTES.INI, as shown below:

ServerTasks=Router,Updall,Replica,AdminP,CLDBDIR,CLREPL,CLREPL,CLREPL

Make sure all CLREPL tasks are listed after the CLDBDIR task. The Cluster 
Replicator relies on information provided by the Cluster Database Directory 
Manager.

For more details about cluster replication, see Chapter 5, “Administering 
Domino clusters” on page 119.

4.3.6  Changing cluster membership
A server can easily be moved from one cluster to another, or removed from a 
cluster to be a standard Domino server.

To move a server from one cluster to another, you simply add the server to 
the new cluster. Domino automatically removes the server from the old 
cluster. For more information, see 4.3.5.1, “Adding servers to a cluster” on 
page 98.

You can remove a server from a cluster using the Administration Client.

1. Open the Domino Directory on the server specified as the Administration 
server for domain.

2. Select the Configuration tab.

3. Expand the Cluster section in the left pane.

4. Click Clusters.

5. Select the server(s) that will be removed from the cluster.

6. Click Remove from Cluster. This can be seen in Figure 31:
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Figure 31.  Removing a Domino server from a cluster

7. Confirm that removal should continue by clicking Yes in the Verification 
dialog box.

8. Decide if the server should be removed immediately or through the 
Administration Process and click the appropriate button as shown in 
Figure 32:

Figure 32.  Choosing when to remove the server

9. If your choice in step 8 was Yes, then a confirmation dialog box will be 
displayed. Click OK.

10.If your choice in step 8 was No then the request will be submitted to the 
Administration Process.



Chapter 4. Installing and configuring a Domino cluster 105

11.The cluster processes CLREPL and CLDBDIR will be stopped on the 
server, and the relevant entries removed from the ServerTasks setting in 
NOTES.INI.

12.Entries relating to databases hosted by the server being removed will be 
purged from the replica copy of the Cluster Database Directory on the 
least busy of the remaining cluster servers.

13.The local Cluster Database Directory will be deleted from the server that is 
being removed from the cluster.

14.Schedule Manager deletes the clustered Free Time database 
(CLUBUSY.NSF) and creates the Free Time database (BUSYTIME.NSF).

4.3.7  Joining a cluster
Follow the steps below to upgrade a standard Domino server to a clustered 
server:

1. Upgrade the Lotus Domino software to Domino R4.61 or later, or if you are 
already running R4.61, install Lotus Advanced Services. If you are running 
Domino R4.62 and later or Domino R5 you need to install Domino 
Enterprise Server. The installation steps are described in 4.3.1, “Installing 
the first Domino server” on page 84.

2. Verify the Domino port configuration. You need to define at least one 
TCP/IP port for cluster traffic. The client traffic can either run on the same 
port or on another port, which can be running any protocol that Domino 
supports. If you are using only one port, then you must run TCP/IP on that 
port.

The cluster traffic does not require a separate network link but, as stated 
previously, we recommend this due to the increased network traffic 
created by event-driven cluster replication.

You can find details on how to define ports in 4.3.2.2, “Port and named 
network configuration on the first server” on page 90.

3. Edit the NOTES.INI file or create a Configuration document to make 
bindings between the port names and TCP/IP addresses as described in 
4.3.5.2, “Dedicating the private port to cluster traffic” on page 99.

4. Now you are ready to add your server to a cluster. See 4.3.5.1, “Adding 
servers to a cluster” on page 98.
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4.4  Installing Domino R5 for Linux on IBM Netfinity servers

In this section we discuss those Domino installation and configuration steps 
that are specific to Linux. In particular, we examine:

  • Linux patch requirements for Domino R5

  • Preparing Linux for Domino installation

  • Disabling services on Linux

  • Installing Domino on Linux

  • Configuring Domino on Linux

  • Starting and stopping Domino on Linux

4.4.1  Linux patch requirements for Domino
Identifying the required patches for Linux is difficult because there is no 
single defined Linux distribution. The various distributions, Red Hat, SuSE, 
Caldera, TurboLinux, and so on, are at different levels, with different 
combinations of code packages included and available. By setting 
requirements based on kernel and library levels, however, and then 
evaluating each distribution based on this, a set of requirements can be 
determined.

By certifying and supporting distributions, a certain set of patches is 
guaranteed. At the lowest level, Linux kernel 2.2.5 or greater is required, 
along with glibc 2.1.1 or greater, and libstdc++ 2.9.0 or greater. Each of the 
supported/certified distributions contains these levels or higher.

There is one exception to this rule: the version of glibc/libstdc++ installed 
must contain the libstdc++-libc6 naming convention. If it does not, you must 
make the appropriate link yourself. For example, in Red Hat 6.0, the file is 
/usr/lib/libstdc++-libc6.1-1.so.2. In Caldera 2.2, this naming convention is not 
used and therefore you must link /usr/lib/libstdc++-libc6.1-1.so.2 to the file 
/usr/lib/libstdc++.so.2.9.0 , which is the appropriate library. A distribution that 
meets these requirements should be able to accommodate the Domino 
server.

The upgrade from Red Hat 6.0 to Red Hat 6.1 contains patches to the Linux 
kernel that allow larger process/thread limits and increased file descriptor 
limits for greater utilization of server resources. Other distributions may offer 
similar changes from release to release.
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4.4.2  Preparing Linux for Domino installation
Before you can install Lotus Domino for Linux you must ensure that the Linux 
server is correctly configured and ready for the installation. To run Domino for 
Linux you must create Linux user and group accounts to own and run the 
Domino server on Linux. To create a user account you must run the 
configuration utility for your distribution of Linux. For convenience, these are 
listed in Table 9:

Table 9.  Linux configuration utilities

Select a user account name and a group account name that will be unique to 
your company. As a security precaution, we recommend that you do not use 
obvious names such as “notes”, “domino”, “lotus” or variations of these.

4.4.3  Disabling Linux services 
Most Linux distributions enable services for the following by default: NNTP, 
SMTP, IMAP, POP3, and HTTP. In order to use the versions of these services 
provided by the Domino server, you must disable the corresponding Linux 
services. For IMAP and POP3, this is most easily done by editing the 
/etc/inetd.conf file and commenting out the entries for POP3 and IMAP. To 
disable SMTP, NNTP, and HTTP, you must use the appropriate utility for your 
particular Linux distribution.

For more details on how to disable or modify services, see the IBM Redbook 
Lotus Domino R5 for Linux on IBM Netfinity Servers, SG24-5968.

4.4.4  Installing Domino
Now that your Linux server is prepared, you need to obtain the Domino code 
for installation on the server. Lotus Domino for Linux can be obtained in two 
ways; you can download the code directly from the Web or purchase a 
CD-ROM from Lotus.

4.4.4.1  Domino code downloaded from the Web
You can download Domino for Linux from the World Wide Web at:

http://www.notes.net

Distribution Utility

Caldera coastool

Red Hat linuxconf

SuSE YaST, command-line utilities and files

TurboLinux turboservice

http://www.notes.net
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The code you download is in the form of a .tar file. .tar files are Tape ARchive 
files and are similar to .zip files in that they contain a collection of other files 
and information about the directories that they reside in. They differ from .zip 
files in that the contained files are not compressed.

To be able to install Domino, you need to unpack the .tar file and place the 
files in their appropriate directories. This process is performed by the Linux 
utility called tar. From the command line enter the following command:

tar -xvf filename.tar

Upon completion of this command, a new subdirectory, named linux, will have 
been created in the current directory and the files from the .tar archive will 
have been extracted to it. Change directories to the linux directory by using 
the cd command:

cd linux

Then type:

./install

to invoke the text-based installation script for Domino.

4.4.4.2  Domino code on a CD
If you have the CD-ROM version of Domino for Linux, you will need to mount 
the CD-ROM and run the install script from there.

To mount the CD-ROM, insert the Domino for Linux CD-ROM and enter the 
following command:

mount /dev/cdrom

Once the CD-ROM is mounted, you install Domino for Linux by issuing the 
following command:

/mnt/cdrom/linux/install

Do not change directories to the CD-ROM device. Issue the command from a 
directory on the hard-disk drive.

The install command will invoke the text-based installation script for Domino.

4.4.4.3  Installation
Follow the on-screen instructions to install the Domino software to the Linux 
server. The same steps are used regardless of the distribution of Linux that 
you are using.

http://www.notes.net
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Make sure that you choose the Domino Enterprise Server option during the 
installation process, if you plan to add this server to a cluster.

If you need more detailed information to help you install Domino for Linux, we 
recommend the IBM Redbook Lotus Domino R5 for Linux on IBM Netfinity 
Servers, SG24-5968.

4.4.5  Configuring Domino 
So far you have prepared the Linux server and installed the Domino software. 
As there is no Notes client for Linux and the configuration requires local 
access, a Web browser is used to configure the server.

You can use a browser locally on the Linux server, or use a browser from 
another computer that can connect to the Linux server using TCP/IP over the 
network. You must use a Web browser that supports graphics and Java.

To configure Domino, you will use the Lotus Domino Web server in initial 
configuration mode. The Web server is started from the Linux command line. 
First change directories to the Domino data directory:

cd /data

Then issue the following command:

/opt/lotus/bin/http httpsetup

This will launch the Web server and use the SETUPWEB.NSF database to 
complete the configuration. The Web server listens on port 8081 and will only 
provide access to the setup configuration database.

Using a Web browser, enter the following URL:

http://<server>:8081

where <server> is the TCP/IP address or DNS name of the Linux server. When 
your browser loads the page returned by the server, you will see the familiar 
windows that are used to configure the Domino server. Just as in all other 
Domino server platforms, you need to fill in the appropriate information for 
your Domino installation. This will be similar to any other additional Domino 
server installation. The installation process was explained earlier, in 4.3.4.2, 
“Server configuration” on page 96.
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4.4.6  Starting and stopping Domino 
To start the Domino server for the first time, issue the following command 
from the command line:

/opt/lotus/bin/server

For additional flexibility and security reasons, we recommend that you start 
the Domino server from a script. Some examples of Domino startup scripts 
can be found in the IBM Redbook Lotus Domino R5 for Linux on IBM Netfinity 
Servers, SG24-5968.

After starting the server, the Domino console appears and is identical to that 
found on all other supported platforms. You can now issue commands from 
the console as you would from any Domino server, or you can connect from 
another system by using the Windows Domino R5 Administration client.

There are several ways to stop your Domino server on Linux:

  • From the foreground server console:

Type exit or quit to shut the server down.

  • From the Domino Administrator client, follow these steps:

a. Open the Domino Administrator client.
b. Click Server -> Status.
c. Choose the server you wish to shut down and select Tools -> Server 

-> Shutdown from the Tools pane, or Server -> Server -> Shutdown 
from the menu bar.

d. You will be prompted to confirm the shutdown. Click Yes.
e. The Domino Administrator will confirm that the server has stopped by 

indicating that it no longer responds.

  • From the Linux command line:

To shut down the Domino server from the Linux command line, make sure 
you are logged in with the user account you created for running the 
Domino server. Type server -q to shut down the server. The directory 
containing the installation binaries, /opt/lotus/bin, must be in the user’s 
PATH statement.

  • With a stop script:

You might decide to create a script file to stop a Domino server. An 
example of a Domino stop script can be found in Lotus Domino R5 for 
Linux on IBM Netfinity Servers, SG24-5968.



Chapter 4. Installing and configuring a Domino cluster 111

4.5  Setting up calendaring and scheduling

A Domino server that is not clustered contains a database that includes 
scheduling information for all users who use that system as their mail server. 
This database is named BUSYTIME.NSF and is known as the free time 
database. In a cluster, there is a single free time database for everyone 
whose mail server is a member of the cluster. This database is named 
CLUBUSY.NSF and it contains all the information that was in the individual 
free time databases of all the servers that became cluster members. Each 
server in the cluster contains a replica of this database.

When you add a server to the cluster, the Schedule Manager deletes the 
server’s BUSYTIME.NSF database and creates its replica of CLUBUSY.NSF, 
which is synchronized with the other replicas in the cluster. When a user in 
the cluster requests free time information, the server looks in its own 
CLUBUSY.NSF first to find information for every user in the cluster. For users 
whose mail servers are outside the cluster, requests are sent to those servers 
for the free time information. Whenever there is a change to the 
CLUBUSY.NSF on any server in the cluster, the Cluster Replicator updates 
the other replicas in the cluster.

When you remove a server from a cluster, the Schedule Manager deletes 
CLUBUSY.NSF from that server and recreates BUSYTIME.NSF. The 
Schedule Manager on each server in the cluster removes the deleted 
information from its replica of CLUBUSY.NSF.

If there are Domino R4.x servers in a cluster, they maintain their 
BUSYTIME.NSF databases. These databases are not converted to 
CLUBUSY.NSF. Calendaring for these servers works the same as in a 
non-clustered environment.

If one of the clustered servers is unavailable, mail users will fail over to 
another server in the cluster that has a replica copy of their mail files. These 
users will then be able to continue using their mail as they usually do. In this 
situation, we discovered that free time search and group calendar-related 
operations are either not available or appear to be working but present 
incomplete information based on data entered by the user prior to the failover. 
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In our lab we were able to reproduce these problems with calendaring and 
scheduling in a clustered Domino R5 environment.

1. For example, user A has a home mail server (Server A) that is clustered. 
When his home server becomes unavailable, he fails over to the other 
server in the cluster that has a replica copy of his mail database (Server 
B). User A continues to work with his mail and schedules several 
meetings. User B now wishes to book a meeting with user A, and so wants 
to check user A's schedule.  A free time search in this case returns 
incorrect information. It shows that user A is free for any time slot that he 
has filled since the failover. This occurs for all entries user A added to his 
calendar after his home server became unavailable. It appears that the 
Scheduler task on Server B does not update information in CLUBUSY.NSF 
for those users that have Server A as their home mail server.

Once Server A becomes available, the Scheduler task on Server A 
updates Server A's copy of CLUBUSY.NSF, which is then cluster 
replicated to Server B.

Figure 33 shows an inaccurate result from a free time search made while 
the user’s home mail server was not reachable, and both chair and 
invitees had their mail databases on Domino servers in the same cluster.

Figure 33.  Free Time search in a clustered environment

Even though meetings were booked in the requested time slots, the free 
time search shows them as available.
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2. User A has a clustered server as his home mail server, which we stopped. 
When user B (who is using another Domino server in the cluster as his 
home mail server) opens his/her own mail database and tries to open user 
A’s calendar by selecting Tools -> Calendar Tools -> Open Another 
Calendar, failover does not occur. User B will get a Server Not Responding 
error message.

This shows that the formula corresponding to the Open Another Calendar 
menu option, @Command([OpenCalendar]), does not support cluster 
failover. 

3. When a user retrieves a group calendar for a group that has members 
whose home mail server is clustered and unavailable, he receives 
incomplete calendar data for these users. Information entered by group 
members prior to their home mail server failure is shown properly. Any 
schedule data entered after their home mail server failure is shown as free 
time. Also, when a user tries to display the calendar for a user whose 
home mail server was clustered but unavailable, clicking user B's name 
produces the following error message:

Unable to open user's mail database.

4. When user A, whose home mail server resides outside the cluster, makes 
a request for free time information about user B, whose home mail server 
is a cluster member that is unavailable in the cluster, the request does not 
fail over. Free time information is shown as No Info.

Figure 34.  When Free Time search does not work
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We have no firm information to indicate that this behavior will be modified, 
but Lotus is aware of the problem and we anticipate that correct operation 
will be incorporated into Domino in a future update. 

4.6  Configuring Internet Cluster Manager

An Internet Cluster Manager (ICM) is dedicated to a single cluster. So, if you 
have two clusters, you must have at least one ICM for each cluster. The ICM 
needs to be in the same domain as the Domino cluster because the ICM 
always uses the local copy of Domino Directory.

The ICM is a Domino server task that ships as part of Domino R5 clustering. 
To install the ICM, you must install the Domino Enterprise Server. The ICM is 
automatically installed as a part of the Domino clustering support that ships 
with R5 Domino Enterprise Server.

You can configure the ICM settings on one server and have more than one 
server accessing these settings.

4.6.1  Setting up ICM
To configure the ICM, you make entries in the Internet Cluster Manager 
section of the Server document in the Domino Directory.

1. From the Domino Administrator, select the Configuration tab.

2. Expand Server and click All Server Documents.

3. In the Results pane, select the Server document for the server on which 
you want to run the ICM; then click Edit Server.

4. Select the Server Tasks -> Internet Cluster Manager tab and complete 
the following fields:

Be sure to include the ICM configuration information on every server on 
which you run the ICM, as well as on every Web server in the cluster.

Note
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Table 10.  Entering the ICM settings

If the ICM runs on the same system as the Domino HTTP server, you can 
configure either the ICM or the HTTP task to run on separate ports or to run 
with different TCP/IP addresses in order to avoid conflicts. We recommend 
that you assign the ICM its own TCP/IP address.

Section Field name Description

Basics Cluster name The name of the cluster the ICM will 
service. If this field is blank, Domino uses 
the name of the cluster that contains this 
server.

ICM Notes port The name of the Notes port the ICM will 
use to communicate with HTTP clients. 
This field is blank by default, so that ICM 
can use any Notes port.

ICM SSL keyfile The name of the SSL key file that contains 
certificates to identify the ICM when 
communicating with HTTP clients.

Allow users to browse 
databases in the cluster 
over HTTP

Allows HTTP clients to view a list of all 
databases in a cluster.

Configuration Get configuration from You can specify a different Server 
document from which to get the 
configuration data.

Obtain ICM 
configuration from

This field appears when you select 
another server document in the field 
Get configuration from:

ICM hostname This is the fully qualified name of the host 
that clients should use to communicate 
with ICM.

ICM HTTP 
Port Settings

TCP/IP port number The port number that ICM will use. If you 
run the ICM on the same server as the 
Web server, you must avoid address and 
port conflicts.

TCP/IP port status Choose Enabled to allow HTTP 
communication with the ICM.

SSL port number Enter the port number to use for SSL.

SSL port status Choose Enabled to allow HTTPS 
communication with the ICM.
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The Host name(s): field in the HTTP section of the Server document must 
match the entry found in the Fully qualified Internet host name: field on the 
Basics tab in the same document. The ICM fails if they do not match.

4.6.2  Starting ICM
If you want to start the ICM every time you start the server, append ICM to the 
ServerTasks setting in NOTES.INI:

ServerTasks=Router,Replica,AdminP,HTTP,ICM

If you want to start the ICM manually while the server is already running, use 
the following command at the server console:

load icm

4.7  Hints and tips for installation problems

The following sections include hints and tips to help you if you are 
experiencing problems with installing Domino clustering.

4.7.1  Check NOTES.INI
Check the ServerTasks and the Server_Cluster_On settings. The ServerTasks line in 
NOTES.INI should include the tasks CLDBDIR and CLREPL.

Make sure that CLDBDIR is listed on the ServerTasks line before the CLREPL 
command. The CLDBDIR is responsible for building and maintaining the 
Cluster Database Directory, CLDBDI.NSF. The Cluster Database Directory 
must exist for the cluster replicator to load.

Also make sure that the cluster is enabled with the following entry:

Server_Cluster_On=1 

4.7.2  Cluster Database Directory
The Cluster Database Directory (CLUBUSY.NSF) contains an entry for each 
database within the cluster. Look in this database to make sure all databases 
within your cluster are listed. For example, if a database within your cluster is 
not pushing changes to a cluster member that contains a replica copy of this 
database, you can investigate by making sure the entry for each replica exists 
in the Cluster Database Directory. 

A missing database entry within the Cluster Database Directory is usually 
due to the Cluster Manager failing to initially replicate with other cluster 
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members during that server's addition to the cluster. Forcing a replication with 
a cluster member rectifies this issue.

To help ensure that the Cluster Database Directory is kept up to date, you 
should also use a standard replication task as a backup to cluster replication.

4.7.3  Using the Server Web Navigator in a cluster
If you use the Server Web Navigator in a cluster, make sure that the Web 
database (WEB.NSF) on the cluster servers are replicas. Since the Web 
database is generated automatically when you start the Server Web 
Navigator task, it is a common error for the clustered servers to contain Web 
databases that are not replicas of each other. Therefore, these databases do 
not fail over to each other.

To be sure that the Web databases are replicas, start the Server Web 
Navigator on only one of the clustered servers. Then replicate the Web 
database to the other cluster servers before starting the Server Web 
Navigator on those servers.

4.7.4  Choosing a time zone on a Linux server
Linux uses GMT (Greenwich Mean Time) internally. All internal Linux 
operations are done using this one time setting. For example, file time stamps 
are stored based on GMT. Displaying times in “local time” is a user interface 
issue. This strategy allows meaningful data exchange over a WAN (over the 
Internet being an obvious example).

To show the time correctly, Linux must be told which time zone applies to the 
server’s location, that is the difference between local time and GMT.

To change the time zone, you will need to run the configuration utility for your 
Linux distribution. The zone field allows you to select the zone/country code 
that reflect how the time is managed at your location. This selection also 
influences the deviation from normal time used in some countries (winter time 
versus summer time).

In the Domino environment, a setting called TimeZone is defined during the 
Notes workstation or Domino server setup procedure. Time zones begin at 
Greenwich and move westward around the world. For example, TimeZone=5 
represents the US Eastern Standard Time (EST) while TimeZone=0 
represents Greenwich Mean Time. This setting is held in the Local time zone 
field in a Location document for workstations and the Local time zone field in 
the Server document on a server.
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Confusion can arise if you choose “numeric” selection while configuring time 
zones during a Domino for Linux installation. We made this error ourselves, 
so felt it worth pointing out. When we first configured the time zone on our 
Linux server we chose the following value:

GMT-5

This was because our location, Raleigh, is in the US EST time zone which is 
five hours behind (hence “-”) GMT. Our Linux Domino server interpreted this 
as ZE5 (five hours east of GMT). So, we changed our Linux setting to a 
non-numeric value to avoid this confusion:

US/Eastern

Our Domino server then correctly reported its time and time zone.


